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Introduction
This data acquisition system can simultaneously read data from multiple sources and control multiple output signals 
in a synchronous manner. The data acquisition process is defined by a protocol, where you can set a sequence of 
events, such as start and stop of data recording and output of analog signals. A single protocol can simultaneously 
control different devices, such as analog interfaces and amplifiers. The protocol can also specify the analysis of re-
corded data, which is performed during data acquisition. The system saves all its recorded data, analysis results, and 
protocol definitions in a single data file. You can also define custom data that will be associated with recordings to 
better describe the recorded data. The program also provides convenient browsing through the data files, by showing 
a preview of traces, plots and graphs.

The system can be configured to provide both a generic user interface to control any digital or analog signal, as well 
as to control common types of instruments, such as known brands of electrophysiological amplifiers. These settings 
can be easily shared between multiple users. Settings for several common instruments are included with the system.

Demo Download Insturctions:
You can download a demo version of this application along with sample protocols and recordings. First, download 
the “demo.zip” file using URL: http://biosciencetools.com/catalog/links/demo.zip. Unzip the demo.zip file. This will 
create a folder “Bioscience Tools”. Open the folder and double-click on file “runDEMO”. Load simulation settings: 
click on menu “Device” and select “Test ADI Device1”; from the bottom of the pop-up window click “Load...”. 
Select file “Settings” in subfolder “Bioscience Tools/Settings”. Click “OK” to close the pop-up window. Then, click 
on menu “Protocol” and select “Load Protocols...”. Choose subfolder “Bioscience Tools/Settings” and select file 
“Sample-Protocols”. The “Bioscience Tools” folder also contains this User Guide as a PDF file.
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Quick Tour
How to Start
The data acquisition system is shipped installed on a computer. It can also be preconfigured and pre-programmed 
according to your experiment requirements and instruments used. Some experience with Windows, or similar, 
operating systems is required to run this application. After powering the computer, you can start the application by 
double-clicking the “Bioscience Tools” icon located on the Desktop.

Creating the Protocol - Protocol Editor
When the application starts for the first time it presents a window, 
which is mostly empty (Fig. lA). This window is the control center 
where the acquisition protocols are created and activated: Protocol 
Editor. To create your first protocol, select “Protocols ->New proto-
col” from the menu located on the top of the Protocol Editor. A new 
item, named “Untitled Protocol”, will appear in the top right panel 
of the window. The protocols will be shown in this panel as a tree 
structure.

Let’s first change the name of your new protocol. Click on the Untitled 
protocol to highlight its name and then click the second time to edit the 
name (similar to the way you would rename a file in a file browser). 
Alternatively, press the “SPACE” bar to start editing the label of any 
selected item. Type in the new name “Test” and press “ENTER” on 
your keyboard. Note that the name of the currently selected protocol is 
also selected in the pop-up list in the top-left corner of the window, Fig. 
1B. This list provides quick access to your protocols. Try adding more 
protocols to see how it works. 

Adding Input Channels
Now let’s add some content to the protocol. First we need to add a channel that will provide input data. Right-click 
on the protocol name and select “Add Input Channel” from the pop-up menu, Fig. 1C. A new item named “New 
channel” will be added to the protocol, Fig. 1D. Initially, it is marked with a red exclamation point indicating that the 
program is not able to associate this channel with any device. We will fix this later.

Fig. 1C

Fig. 1D

Fig. 1B

Fig. 1A
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Adding Events
To do anything with this channel the protocol has to specify the time 
to perform an event and the type of action. These, like everything 
else, are specified by adding corresponding items to the protocol. 
Right-click on the protocol name and select “Add Event”, Fig. 2A. 
The event specifies the time during protocol execution. The first 
event, which we just created, can mark the beginning of the record-
ing, for example. We can change the event name to reflect this fact. 
Click on the event to select it, press the “Space” bar and type the 
new name “Start”. Right-click on the event and select “Add Action 
On New channel”, Fig. 2B. Since “New channel” is an input chan-
nel, the created action is “Start recording”. This concludes the cre-
ation of the simplest executable protocol. At this point your protocol 
editor panel should look similar to Fig. 2C.

Start Recording
Recording can be started by clicking the start button 
at the top-left of the Protocol Editor. If you click this 
button now, you will get an error message stating that 
protocol channel “New Channel” does not match any 
device. To make a match the protocol channel has to 
have the same name as a channel of one of the open 
devices, which will be described in the following sec-
tions.

Input/Outpot interface -Device Window
Let’s open a device now. Click on the “Device” menu. 
You will see a list of devices found in your system, 
Fig. 3A. In the rest of the tutorial we will use “Test 
ADI device1” - ADI stands for analog/digital interface. 
This is a virtual device that simulates the behavior of a 
real analog data interface with input channels con-
nected to output channels. This device can be used 
to create your demo protocols. If you have a real AD 

Fig. 2A

Fig. 3A

Fig. 3B

Fig. 2B Fig. 2C
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interface installed in your system, you can use it instead. To open a 
device, simply select it from the menu.

Input/Output Channels - Settings Window
When you open the device for the first time the program presents a set-
up dialog, where you can describe different interfaces and instruments 
used, Fig. 3B. We will use the default settings for now, so click “OK” to 
close the window. The program will then ask you to specify a new file 
where the settings should be saved. You can have multiple settings files 
for different experiments, you can also share settings files with other us-
ers who already configured systems similar to yours. Your system might 
also come preconfigured. Give some descriptive name to this settings 
file, such as “Test setup” and save it in the recommended folder. The 
next time you start the program and open the device again, the settings 
will be loaded automatically from the file that you used the last time. 
Furthermore, all the changes you do to the settings will be saved in this 
file automatically, without going through the SAVE dialog again.

Once settings are saved an empty DEVICE Window will open, Fig. 3C. 
For our ADI device this window will work like an oscilloscope or moni-
tor. Initially the window is empty. Now we will associate our protocol 
channel with the input channel of the opened device. This association is 
done by giving the protocol channel the same name as one of the inputs 
used in Settings. You do not need to memorize the names and type them 
in the protocol: right-click on the protocol channel and choose “Select” 
from the menu, Fig. 3D. The dialog lists all input channels available, 
Fig. 3E. Simply select a device channel and click “OK” to rename the 
protocol channel automatically. Note that the channel in our protocol 
is not marked with a red exclamation point any more. The protocol can 
now be executed. Click the “Start” button in the Protocol Editor and 
observe the input data appearing in the Device Window. Our simple 
protocol does not specify stop action so data acquisition will continue 
until you stop it manually. In order to stop the protocol, click on the 
same button you used to start the protocol. This button toggles between 
“Start” and “Stop”, as indicated by the change of the button image.

Device Window
Before we proceed to more advanced protocols let’s first explore prop-
erties of the device. The “Tools” menu of this window lists the controls 
that are available for the current device. The “Channel monitor” tool is 
always available for any ADI device. Depending on device capabilities, 
other tools may be also available. Some instruments can add extra tools 
to the menu.

Fig. 4A

Fig. 3E

Fig. 4B

Fig. 3D

Fig. 3C
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Select “Channel monitor” from the Tools menu, Fig. 4A, and 
examine the controls that appear. The tools are shown to the 
right of the oscilloscope area, Fig. 4B. The name of the tool 
also provides access to the tool menu unique for each tool. 
Menus for all tools have a “Close” option to remove the tool 
and a “Float” option that causes tools to detach from the de-
vice window into a separate floating window.

The channel monitor tool can be used to test the function-
ing of inputs and outputs of the ADI devices. The tool menu 
contains commands for adding additional channels to the 
display. To activate the tool click the “On” button - note that 
it stays depressed after you click on it. Many other tools have 
this button - when it is toggled the tool takes control of the 
device, making all other tools inactive. To STOP the tool, 
click the depressed “On” button again, the button will pop up 
to indicate that the tool is inactive, Fig. 4C

Open the device setting dialog by selecting the “Settings...” 
command from the “Settings” menu of the Device Window, 
Fig. 4D. This dialog allows you to specify physical properties 
of signals connected to your recording system. Select first IN-
PUT channel and type in a new name - “Current” and type in 
physical units - “A”, Fig. 4E. Select the first analog OUTPUT 
channel and name it “Voltage” and define units as “V”. Click 
“OK” to accept these changes.

Creating Voltage Steps Protocol - I-V Curve
Now we will create a more complicated protocol for the am-
plifier instrument that will produce the stimulus and perform 
analysis automatically. Make sure not to close the device 

Fig. 4C

Fig. 4D

Fig. 4E

Fig. 5
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window while creating this protocol. Create a new protocol, rename it to 
V-Test. Right-click on its name and select “Add new input channel”. This 
time, the channel selection dialog will open automatically - this always 
happens upon the addition of new channels to a protocol, when there is at 
least one device open. Select “Current” for input. Add an output channel, 
select “Voltage”. Add four events, rename them to “Start”, “Step”, “Rest” 
and “Done”, in that order. Add actions on current to “Start” and “Done” 
events. Add actions on voltage to “Step” and “Rest” events. Right-click 
on the first action on voltage and select “Set Value”. Type “0.1” into the 
editor that appears. Your protocol editor should now look similar to Fig. 
5.

Note that the plot view in the lower part is dynamically updated as you 
edit the protocol. The position of the currently selected event is high-
lighted on the plot to help you locate the event, which is currently being 
edited. You can also use the plot to navigate to the event - simply click 
anywhere inside the plot area and the closest event will be selected on the 
tree view. 

Note that we only specified an output value for voltage in the “Step” 
event. We did not specify starting “holding” value or the value in the ac-
tion inside the “Rest” event. The value here is determined by the default 
value set using the Channel Monitor tool. Try changing the voltage using 
the Channel Monitor tool in the Device Window and note that the proto-
col plot is updated to reflect the changes. 
This illustrates the general rule of protocol editing: many properties do 
not have to be specified explicitly because default values are used. Some 
properties do not have default values, such as the sampling period for the 
input channel.

By default a protocol is executed once during recording. The program 
allows multiple executions of the same protocol with changes to some of 
its properties during every execution. Let’s explore this. Right-click on 
the V-Test protocol you just created, select “Change Count” and type in a 
value of 10. Now after starting the recording the protocol will be executed 
10 times, but every execution will be the same. To add variation right-
click on voltage action that is inside “Step” event and select “Set Value 
Increment” command. Type value -0.01 into the newly created item. At 
this time your protocol editor should look similar to Fig.6.

You can now press the start button to observe protocol execution in the 
Device Window. If you use a virtual test device you should see step 
traces, since this device directly connects voltage OUTPUT to current 

Fig. 6

Fig. 7
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INPUT. If you are using a real device you will need to provide some feedback from voltage to current channels to 
see the effect of variations in voltage.

Let’s save the recording into a file for later analysis. In the “File” menu of the Protocol Editor select “New” and type 
the name and select location for your new file. By default the program gives the current date as the name of the file. 
The file is immediately created on the disk since the program does not keep all recorded data in its memory during 
recording but streams data to the file on the disk. A new File Window will appear. Before we start exploring the file 
window let’s put some data into the file. In the Protocol Editor choose the file name using the File list selector that 
is located under the protocol selector and is marked with “File:” label. This selector specifies which open file, if any, 
will receive the recorded data. Select your newly created file. Now make sure that V-Test is selected in the protocol 
selector and start recording by pressing the start button. Observe data traces appearing both in the Device Window 
and in the File Window. After recording is finished the File Window should look similar to Fig.7. 

The upper panel of this window shows recorded data in a hierarchical tree structure. Multiple recordings can be 
stored together inside a group of items that look similar to folders on a computer disk. Data recorded from every 
input channel during single execution of the protocol are represented by a separate entry under the main recording 
(labeled “V-Test” in Fig. 7). 

The lower panel of the File Window  (Fig. 7) contains several overlapping tabs that show various types of informa-
tion about the currently selected item of the file structure. The “Data” tab graphically displays recorded data for 
the selected item. Click on the “Info” tab to see various text information about he selected item. Most of these Info 
fields will be the same as those in the Info area of the Protocol Editor, but you might also have some extra fields 
added during recording, such as the date and time when the recording was made. Click on the “Prot” tab to see a plot 
of the protocol used to record the selected item.  When you double-click on the item or select it and press “Enter” a 

Fig. 8 Fig. 9
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separate Plot Window showing the item data will open. This win-
dow allows you to perform some additional operations depending 
on type of data. For example, open the Plot Window for recording 
item “V- Test”. The Plot Window allows you to perform analysis of 
traces on it. Select “Analyze” from the “Data” menu of this window. 
The analysis panel will be added to the window (Fig. 8). Press the 
“Analyze” button on the panel to perform the analysis according to 
the settings in the control panel. A new window will appear show-
ing the results of analysis. For details about the program’s analysis 
capabilities see the corresponding section in the manual.

In order to make the program automatically analyze the traces dur-
ing recording we need to add analysis requirements to the protocol. 
Right-click on “V-Test” in the protocol panel and select “Add analy-
sis” from the menu that appears. An analysis item will be added 
following the last event, as shown on Fig.9. You can specify a type 
of analysis to be performed and select the data range for analysis. 
Note that the program automatically selected a time between Step 
and Rest events, which is a logical choice for this protocol. 

Also note that when the analysis item is selected in the editor its 
range is marked on the plot view. 

The next time you start recording, the analysis will be done auto-
matically right after each trace is recorded and results will be stored 
in a separate item within the data file. Note that automated analysis is only performed when data is recorded into a 
file. To see the results simply select the analysis item in the file structure and the results will be shown on the plot in 
the “Data” tab in lower part of the File Window, Fig. 10. You can also double click this item to display the plot in a 
separate window.

The program can also automatically display analysis results in a separate window during the recording. This allows 
simultaneous observation of recorded traces and results of analysis. To achieve this, right-click on the analysis item 
in the protocol editor and select “Autoshow”. The next time you run the protocol, the analysis results window will 
automatically open. To prevent automatic display, either edit the “Autoshow” item and select “No” from the menu or 
delete this item using “Delete” key on your keyboard.

This concludes the guided tour to the program. The following sections will describe various features of the program 
in detail.

Fig. 10
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Chapter 2
In addition to creating and editing the protocols, the main window of the application - Protocol Editor, provides con-
trols for executing the data acquisition protocols. Closing the window will result in exiting from the program and is 
equivalent to selecting the “Quit” command from the “File” menu. The Protocol Editor window is divided into three 
panels: 
- Menus and Recording Control - in the upper left
- Information Panel - in the lower left
- Protocol Editor - covers all the right side of the window 

Recording Control
The Recording control panel has three controls: Start button, protocol selector and file selector. The Start button 
activates execution of the currently selected protocol. Pressing this button during the execution of the protocol will 
interrupt the recordings. The protocol can be selected either using the protocol selector menu located next to the start 
button, or by selecting the protocol name in the editor panel. The file selector specifies the opened data file where the 
data from input channels will be saved during protocol execution. If none is selected, the input data will be displayed 
during execution but will not be saved. 

Information Panel
The Information panel shows a list of properties and information that will be saved to the recorded data file. The 
properties and information are provided by the active interface devices, instruments and tools associated with the 
devices. Their values are updated automatically during the experiment. You can also define your own custom infor-
mation items. 

The program allows you to specify which items you want to be displayed in the Information panel. This is done 
through a “Define info fields” dialog (Fig. 12), which is activated by clicking the button located on the top of the 
Information panel. You can create custom information items through this dialog by clicking “Add”. To remove a 
previously created custom info item, select it in the table and click “Delete”. Items provided by devices, instruments 
or tools cannot be deleted using this dialog. Closing the device window or tool, or removing the instrument from the 
device setup will automatically remove the information items associated with these devices and tools.

To prevent an item from being displayed in the Information panel, uncheck the corresponding check box in the 
second column labeled “Show”. Note that the unchecked items will still be saved to the data file together with data 
during recording and can be viewed in the Information panel of the data file. To change the order of the items use 

Fig. 12
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“Move Up” and “Move Down” buttons that move the currently selected item. 

The name of a custom Info item, displayed in the first column of the “Define Info fields” table, can be modified by 
editing. These names, however, have to be unique. Since similar devices, instruments or tools may provide Info 
items with the same names, the name of these items is qualified by prefixing it with the name of the parent device, 
instrument or tool name followed by colon. Because the colon character has a special meaning in separating the 
name of the Info item from the name of its parent entity, this character can not be used in the names of custom Info 
items. Although the names of automatic items are always shown with a prefix in the “Define Info” dialog, the prefix 
will be omitted in the Information panel if the item is unique in the current system. 

The column labeled “Type” describes the data stored in the  item. Automatic items provide a short description of 
the item that cannot be modified. For custom info items it is possible to specify the type of data by double-clicking 
on the Type field and using the up and down keys on your keyboard to make a menu selection. Currently avail-
able Types are “Text” - a single line of text, “Integer” - an integral number, and “Real” - a real number. The units 
specified in the last column of the table will be used for items containing real numbers, but are ignored for all others 
types. 

The “Store in” column shows the association of the info item with the recorded data item. Association of items pro-
vided automatically is determined by their providers and cannot be altered here. For custom info items, it is possible 
to choose between “Group”, “Recording” and “Unit”. The items with “Group” association will be stored only once 
for each group in the data file at the moment the group is created either manually or with the first recording. The info 
items associated with the group will be used to describe the whole experiment, such as a type of specimen used dur-
ing all recordings. The info items associated with “Recording” will be saved in the beginning of the protocol’s ex-
ecution. The “Unit” association specifies that the info item will be save at the start of every iteration of the protocol. 

Protocol Editor Panel
The Protocol Editor allows you to create, modify and view the experimental protocols. A protocol is represented by 
a hierarchical structure that defines the data input and output channels and the time sequence of events performed 
on the channels. A detailed description of the protocol hierarchy and its editing can be found in a separate chapter 
“Experimental Protocol”.

The editor is divided into two parts. The upper part shows a hierarchical representation of the protocol, where all 
the editing is performed. All defined protocols are listed on the top. The lower part shows a timeline of the currently 
selected protocol. This plot provides an overview of the whole protocol and simplifies navigation within the protocol 
hierarchy. Clicking inside the plot will highlight the event closest to the mouse pointer and will select this event in 
the hierarchical view above.

Selecting an item in the hierarchy within the protocol will highlight the event on the plot. Selecting any item within 
the protocol will select the protocol for execution and its name will be selected in the protocol selector of the 
Recording Controls panel. Alternatively, choosing the protocol in the protocol selector will select the protocol in 
protocol editor, allowing faster navigation through the protocol structure. 
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Menus

File

New: Create new data file.
 
Open: Open an existing data file.

Quit: Exit the program 

New Timer: Creates a new timer window. See section “Timer” for usage of timers in the program.

Protocol

New protocol: Creates new empty protocol. 

Duplicate protocol: Creates a copy of currently selected protocol. 

Load Protocol: Loads a previously saved set of protocols from a file. Note that this file becomes the default storage 
file for the protocols. All changes made to protocols in the editor will be automatically saved in this file. Also the 
protocols will be automatically loaded from this file the next time the program is started. 

Save Protocols: Saves the current set of protocols into a new file. Note that this file becomes the default storage file 
for the protocols. All changes made to the protocols in the Editor will be automatically saved in this file. Also the 
protocols will be automatically loaded from this file the next time the program is started. 

Device

This menu lists all the interface devices that the program finds in the system. Note that this list can change as a result 
of the connecting or disconnecting of external devices. Selecting the device in the menu results in opening a new de-
vice window, if it was not already opened. This window becomes active and is shown on top of the other windows. 
The devices that have their windows opened are referred to as opened devices. Opened devices are checked in the 
“Device” menu. Protocols only work with channels from opened devices. Upon exiting from the program a list of 
opened devices is remembered and the program will attempt to open these devices the next time it starts. 

Device Windows

Each active interface device in the system is represented by its own device window. The program does not acquire 
data from or control devices that are not activated and do not have their window opened. Most of the Device win-
dow area is used for monitoring data acquired from the device. In the case of the analog/digital interface the window 
behaves like an oscilloscope showing signal traces.
The area along the right site of the device window may contain a number of control tools. These tools can be used 
to control the state of the device and instruments connected to the device. A list of available tools depends on the 
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type of device as well as on the instruments configured within the device. Currently available tools are listed in the 
“Tools” menu, which is used to open the tools. 

When a Device Window is opened for the first time a device setup dialog is displayed automatically. Approving the 
settings by clicking “OK” will result in the program asking for a file name to store the settings. Any further changes 
to the device settings will be saved to that file. The next time the device opens the setting will be automatically 
loaded from this file. The Settings dialog can be opened from the “Settings” menu of the device window. 
Further details about device settings and tools are in the chapter “Devices” and your device reference manuals.

Data File Window

The File Window shows the data file structure and contents. The name of this window is the actual data file name. 
All data and information assotiated with the protocol are stored in a single file. The program may have several files 
opened simultaneously, but only one file can be selected for saving the data during protocol execution. The file for 
recording is specified by the file selected in the Protocol Editor, Fig. 13A. To create a new data file or open an exist-
ing file use the “File” menu, Fig 13B.

The File Window (Fig. 13C) is devided into two parts. The top part of the window shows the file structure. The 
lower part contains tabbed graphical views of recorded data, under tab “Data”, experimental conditions, “Info”, and 
protocol sequence, “Prot”. Each data recording is represented by an icon and a text label. The text label may be ed-
ited by selecting the item and then clicking on it again or pressing the “Space” key on your keyboard. The text label 
may be prefixed with unchangeable text provided by the program that further describes the item. This prefix text, if 
present, is separated from the user-specified text by a colon, and does not appear during label editing. 

The data are organized into a hierarchical structure similar to file structure on the computer hard disk. Grouped data 
items (hereafter called “group items”), similar to folders on a hard drive, are on top of the structure. The group items 
can only be on the top level of file hierarchy and cannot contain other group items. Data recorded during a single 
execution of the protocol, are further grouped together under recording items, “V-Test” in Fig. 13C. The recording 
item is labeled by the name of the protocol. A copy of the protocol used during recording is saved within the record-
ing item.

To view the protocol hierarchy, all the protocols in the file can be made visible by selecting from the menu “Data --> 
Show Protocols” on the top of the File Window, Fig. 13D. The graphical representation of the protocol for the cur-

Fig. 13BFig. 13A
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rent recording item is also shown under the “Prot” tab in the lower sec-
tion of the window. You can also drag the event item from the protocol 
hierarchy in the Protocol Editor onto the Prot tab window, and the event 
will be shown as a marker on the plot. If the event time varies between 
iterations of the protocol, the program will ask if you want the index of 
iteration to display on the plot. 

The data recorded from every input channel during each iteration are 
represented by a separate entry within the recording item. The program 
supplies labels for recordings made with iterated protocols including the 
iteration number and possibly a value of the output channel that varied 
with every iteration. For protocols with multiple input channels and 
for single execution protocols the label contains the name of the input 
channel that was the source of the data. 

The lower part of the File Window contains tabbed graphical views 
showing various properties of the selected item.
“Data” tab: Displays a preview of the data contained within the se-
lected item or its nearest predecessor containing the data. If a recording 
item is selected, data from multiple channels and all iterations of the 
protocol are displayed, Fig. 13C. The recorded data can also be dis-
played in a separate Plot window by double-click on the item. To add 
another recording to this Plot window drag-and-drop the item into the 
window. 

“Info” tab: Displays information items describing various experimental 
conditions at the time of recording. For additional details refer to sec-
tion “Information Panel”. The Info items associated with the selected 
data and all of its predecessors in the hyerarchy will be shown here. 
This panel allows you to specify which items you want to be displayed, 
the same way as in the Information Panel of the Protocol Editor win-
dow. Filtering and order settings are unique for group items and data 
items so the same information may be displayed in a different order for 
individual recordings and for group items.

“Prot” tab: Displays time sequence of the protocol in a way similar to 
the Protocol Editor. In particular, if the hierarchical view of the protocol 
is enabled from the “Data” menu, clicking on the plot will select the 
nearest event in the protocol view. Selected events are highlighted.

In addition to automatically recorded data and info items the file may 
contain various types of extra information. One example is text notes. 
To create a new text note select “New Note” from the “Data” menu. 

Fig. 13C

Fig. 13D
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The note will be created as the last child of the currently selected item. Text notes can be placed within any kind of 
item, allowing extensive description of the file. To edit the text of the note double click on its entry in the hierarchy - 
this will open a text editor in a separate window. The note does have to contain text - its label may provide sufficient 
space for information that needs to be seen first. The note items can be moved by dragging. To make a copy of a note 
hold down the “Shift” key on the keyboard while dragging. 

File Window Menus

File

Save: Saves changes to the file. Although the data are written directly to the memory disk during the recording, the 
data properties, including the location of various data within the file, are not saved automatically. 

Data

New Group: Creates a new group item as the last item in the hierarchy. All subsequent recordings will be placed into 
the last group item created. Note that if the recording is started into a newly created file that does not have group 
items, a new group will be created automatically. 

New Note: Creates a new text note as the last child of the currently selected item. If no item is selected the note is 
created on the top level. You can drag a note to a different item or even to a different file. You can create a copy of 
the note by dragging with the “Control” key pressed. To edit text inside the note double-click on the note, or select it 
and press the “Enter” key.
 
Delete Item: Removes currently selected item from the file. 

Export Item: Exports currently selected item to an external data format as selected from the sub-menu. This com-
mand is disabled if the selected item does not contain recorded data.

Text (CSV): Exports data as a text file with comma separated values. This format is suitable for import into spread-
sheet software.

Igor Text: Exports data in text format for import into an Igor Pro data analysis software package. 

Show Protocol: Displays or hides protocol used during recording. This menu item has a check mark next to it if 
protocols are currently displayed. The protocol items are shown as children of recording items. This command only 
controls hierarchical display of the protocol items. Graphical representation of the protocol for the selected item can 
also be shown under the “Prot” tab in the bottom part of the File Window. Selecting the event items in the protocol 
hierarchy will highlight the event reperesented graphically in the Prot tab.

Show Components: Displays or hides items representing separate recordings of averaged items and baseline items. 
This item has a check mark reflecting the current settings. Activating this option allows you to remove a recorded 
baseline or some of the recordings used for averaging. 
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Plot Window

Plot windows can display recorded data and results of analysis from multiple files. This window also hosts controls 
for performing interactive analysis. 

To display data in a new Plot Window, double click on a data item in the File Window or select it and press the 
“Enter” key. Opening a trace will produce a window with a single trace on it. It is also possible to open a group item 
- this will display a window with all traces from channels recorded during the protocol iterations. This is used for a 
quick overview of the recorded data. Channels that have different units will be plotted separately. To add data to an 
already opened plot, simply drag-and-drop an item on top of the Plot Window.

The Plot Window allows you to compare data from different files. If vertical or horizontal units of the dropped data 
items do not have corresponding axes on the plot, the new axes will be added automatically.  Every axis has its 
own scrollbar. In addition to common controls used to scroll traces, each scrollbar has two buttons to ZOOM IN 
and OUT. The full scale on all axes can be restored by clicking on an auto scale button on the toolbar. In addition 
to zoom buttons the axis scale can be changed using a selection marquee. The selection marquee can be created on 
a plot by dragging the mouse when the mouse pointer is an arrow. Right-clicking inside the marquee opens a menu 
with options to expand or shrink the scale relative to the marquee.

Right-clicking with the mouse cursor inside a plot area opens a pop-up menu containing commands to auto scale all 
axes or only the vertical or horizontal axis. If the mouse pointer is on top of the trace while right-clicking, the menu 
will also contain commands to reveal the data item corresponding to the trace in the file window, to remove the trace 
from the plot, and to change trace color. For recorded data trace the menu also contains a command to create a timer 
marker with a value corresponding to the horizontal position of mouse pointer. See section “Time Marker” for ad-
ditional details.

The Plot window’s toolbar may contain various buttons depending on type of data shown on the plot:

Autoscale: Restores the scaling of all axes of the plot to show data maximums and minimums.

Arrow cursor: Activates the most commonly used mouse pointer mode - dragging the mouse over the plot area 
produces a selection marquee. Right clicking within the marquee selection results in a popup menu containing com-
mands for rescaling the plot using the marquee as a reference.

Crosshair button: Activates crosshair pointer mode. In this mode the values of the cursor positions are displayed. 
Clicking and dragging the mouse in crosshair mode displays the value difference between start and end positions of 
the cursor.

Beam: This button is visible only when interactive analysis is active. With the beam pointer you can select a range 
on the horizontal axis that will be used for analysis. 
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Show background & Subtract background: If traces have a background signal recorded, the “Show background” 
button and “Subtract background” buttons are added to the toolbar. These buttons toggle between active and inactive 
state when pressed. The “Show background” button shows the background trace data together with the main trace 
data. If the subtract background button is active, the background is subtracted from the main trace, otherwise the 
original trace is shown as it was recorded. 

Stimulus: This button is available for the traces recorded with protocol containing output channels. Activating this 
button will show corresponding stimulation traces that were generated during recording. These traces are similar to 
traces shown in the Protocol editor. Stimulus traces are shown in the same color as the corresponding recorded trace. 
Changing the color of the recorded trace will also change the color of corresponding stimulus trace.

Events: Allows you to mark the events on the plot by vertica lines.

Label Events: Puts event names next to the event marks.

Plot Window menus 

Edit

Copy: Places an image of the plot on the system clipboard. 

Data

Analyze: Starts interactive analysis of the data on the plot. Interactive analysis controls are displayed on the panel to 
the right of the plot. A detailed description of interactive analysis is given in chapter “Data Analysis”.

Export: Exports data to external data format as selected from sub-menu. 

Text (CVS): Exports data as a text file with comma separated values. This format is suitable for import into spread-
sheet software. 

Igor Text: Exports data in text format for import into an Igor Pro data analysis package. 

Timer 
A Timer Window allows you to track time intervals and save timer marks into the data file. The program can have 
several timers active simultaneously. To create a new timer select the “New Timer” command from the File menu 
in the Protocol Editor. The timer is continuously counting time since the last reset. You can reset the timer manu-
ally by clicking the “Reset” button. The timer can also reset itself automatically on certain events as specified by 
the settings. Click the “Settings” button to access the dialog for the timer settings. In this dialog you can specify a 
name for the timer. The name is displayed in the title bar of the timer window and will become the name of the time 
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mark saved to the data file. You can specify when the timer will reset itself automatically by checking the appropriate 
check-box: it can reset when recording starts and when a new group is created in the data file.

To create a time mark in the data file with the current time, click “Save”. A 
dialog asking for comments will appear. The program will show a list of previ-
ous comments used for timer marks in a popup menu. Type in a new comment 
or select a previously used one and press “Enter” or click “OK” to save the 
mark in the data file. The newly created marker will reflect the time displayed 

on the timer at the moment the “Save” button was clicked. If the “Save” button was clicked while the recording was 
active, the time marker will be created inside the recording item, otherwise, it will be created inside the last group 
item. You can move this timer item into the trace recording item, which was recorded at the time the timer item was 
created, by simply dragging the marker onto the recording item in the File window. Having a time marker within a 
recorded trace allows you to display the marker on the same plot window. The timer marker is displayed as a vertical 
line with text comments next to it. 

Time Marker 

A time marker is an item inside the data file that specifies a moment in time during the course of an experiment. You 
may create the marker to designate specific moments during recordings. You may also use the marker as a container 
for notes and analysis results that are related to the designated moment. You can create the marker from the Timer 
window during recording by clicking the “Save” button. You also can create the marker later, after the recording is 
finished, in the plot window showing the recorded trace. To create a marker for a recorded trace, open the trace in 
the plot window by double-clicking on the trace in the File window, then right-click on the point you want marked 
and select “Add timer” command from the popup menu. A dialog will appear where you can enter a comment for 
the marke. The program stores a list of previous comments used for timer marks in a popup menu. Type in a new 
comment or select a previously used one and press the “Enter” key or click “OK” to save the marker. The item will 
be saved inside the trace recording. The program will also add the marker to the graph as a vertical line with the 
comment text next to it.

You can add an existing  marker to the plot window by dragging its icon onto the graph from the File window. Note 
that only the markers that are located inside the trace recordings in a data file can be added to the plot window. This 
is because the time axis on the plot window is not absolute but relative to the start of the trace, so having a time 
marker within the trace allows you to relate the absolute moment of time represented by the marker to the relative 
time of recording. You can move and copy the marker among different traces recorded simultaneously.

Chapter 3: Experimental Protocol 
This system provides a powerful tool for programming time sequences of events to control data acquisition protocol 
using a flexible GUI (graphical user interface). These are some of the advantages of our system: 
- Different types of data acquisition interfaces, such as digital and analog I/O boards, including time-lapsed image 
acquisition devices, can be freely intermixed within a single protocol.
- Existing protocols can be quickly and easily reused with different combination of interfaces and instruments on the 
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same computer system or on a different experimental rig.
- Hierarchical representation of the protocol where you can easily define complicated time sequences, which allows 
you to view important features of a protocol at a glance.
- The program also allows you to specify online data analysis within the protocol itself.
- A collection of frequently used protocols can be stored in a single file.

On the first run of the program you will be asked to save the protocols into a file. You can give any name to the file 
and save it at any location. The next time the program starts, this file will be opened automatically and any changes 
made to the protocols will be automatically saved into this file. You can have multiple protocol files for different 
experiments, or several users can share a single protocols file by keeping it in the location that is accessible by all 
users. To save protocols into a new file select the “Save Protocols...” command from the “Protocol” menu of the 
main window. To load protocols from a different file select “Load Protocols...” from the “Protocol” menu. Once the 
protocol is loaded from the new file, this file becomes the default protocol file and will be used the next time the 
program is started.

Concept

The program represents the experimental protocol as a hierarchy of properties. The protocols are shown, created and 
modified in a protocol editor panel of the Main window (Fig.11). To the user the protocol is presented as a collection 
of expandable container items, each representing a property of the parent item that contains it. The item is shown as 
a labeled icon. If the item contains children, a control for displaying and hiding children is also shown.
The icon and text label describe the property represented by the item. lf an item represents a simple property then 
its value is also included in the text. You can change the value by directly editing the text of the label. Some proper-
ties can only be one of a limited set of choices, in which case the value is chosen from a popup menu. The item that 
groups other properties might not have a value.
It is common for an item to have a name property. For example, each protocol has a name. The name is often not 
shown as a separate child item, but as the text label of an item itself.
Many properties may have default values. By default the protocol is executed only once, for example. To avoid clut-
tering, properties having default values are usually not shown. Further, deleting an item is equivalent to assigning to 
the item a default value. To delete an item, select it and press the “Delete” key on the keyboard. 
The properties are added to an item using popup menu commands that list only properties that can be added to the 
selected item in a given context.

Right click on the item to access its popup menu. When adding new properties the program automatically maintains 
a prescribed order in which the property items are displayed within its parent. This helps to avoid confusion when 
comparing different protocols since you will always find similar properties in the same place. 
Some properties may have multiple instances. The protocol can have an arbitrary number of input channels, for 
example. Multiple instances of such properties are grouped together. It is possible to change the order of items by 
dragging them with the mouse, but the program will not allow you to drag an item outside of its group, which would 
violate the prescribed order. 

Protocol items 
The following is a detailed description of various items that can be present in an experimental protocol. Each item is 
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introduced in order of its appearance within its parent item.

Protocol - This item represents the protocol itself. Its label is the name of the protocol, which is also listed in the 
protocol selector of the main window. You can edit the text label to change the name of protocol.

Protocol menu

Change count: Adds a property that specifies the number of iterations of the entire protocol during execution. 

Change Delay: Adds a property that specifies the time interval between the end of the protocol iteration and the start 
of the next iteration. This command is present in the menu only when the protocol has a Count property with value 
more than 1. 

Change Averaging Count: Adds a property that specifies the number of recordings made to average recording traces. 

Add Input Channel: Adds a channel item for an input channel that is associated with the device that is processing 
your input signals. 

Add Output Channel: Adds a channel item that is associated with your device output.  

Add Event: Adds an Event item to specify a moment in time during protocol execution.

Record Baseline: Requests baseline recording for the protocol by adding Baseline item. 

Add Analysis: Creates new online analysis operation to be performed on recorded data after each iteration of the 
protocol.

Protocol property items

 Count - Integral value. Default = 1. Valid values >= 1. Cannot have user-defined properties. Specifies the number of 
iterations of the entire protocol during the execution. To enter a different number use “Change count” from the pop-
up by right-clicking on the protocol name. 

Delay - Real value. Default value is 0. Valid values >=0. Cannot have additional or user-defined properties. Speci-
fies the time interval between the end of protocol iteration and the start of next iteration. To enter a new value use 
“Change Delay” command, which is present in the pop-up menu only when the Count property is more the 1. 

Averaging Count - Integral value. Default value is 1. Valid values >= 1. Cannot have user-defined properties. Speci-
fies the number of recordings made to average recordings. Use “Change Averaging count” command to enter a new 
value. 

Record baseline - No value. Compound item. When present in the protocol a baseline recording will be performed 
during execution of a protocol. The properties of this item describes how the baseline is performed. The baseline is 
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used for subtracting the background from the recorded data. To define, use “Record baseline” command.
When this item is present in a protocol, baseline recording will be performed during protocol execution. Baseline 
recording can be used to automatically sample the background activity of your experimental sample. A response of 
the system to a small stimulation, for example, can be used to subtract a linear component of the response from a 
non-linear “useful” signal, as it is done in conventional P/n leak current subtraction in patch-clamp recording. 

Record Baseline property items

Count - Integral value. Default value is 1. Valid values >=1. Cannot have additional or user-defined properties. Spec-
ifies the number of recordings made to average traces at every protocol iteration. This property is always present. 

Delay - Real value. Default value is 0. Can not have additional or user-defined properties. Specifies a time inter-
val between the baseline recording and the actual recording. Negative values specify that the baseline recording is 
performed before the actual recording while positive values means that the baseline recording is performed after the 
actual recording. This property is always present. 

Stim. Scale - Real value. Default value is 0.2. Valid values >0. Cannot have additional properties. Specifies the value 
of stimulus scaling. For output channels that have their Baseline Output set to “Scaled”, this value is used to scale 
pulse amplitude. For input channels that have their property “Scale Baseline” set to “Yes”, the recorded values will 
be divided by this scale factor. This property is always present.

Channel

- Input channel. Text value (name). No default. Can have properties.
- Output channel. Text value (name). No default. Cannot have additional proper1ies. 

The channel item specifies the device channel used by the protocol. The text label is the name of the channel. The 
text label can be edited directly, or the channel name can be selected from the list of channels available in the active 
devices. Each protocol will have at least one channel. Use “Add input channel” and “Add output channel” com-
mands. 

The channel item defines your interfaces and instruments input or output used during the protocol. The protocol 
channel is a protocol item that names your device channel used during execution of the protocol. So although it is 
possible to have protocol channels that do not refer to any channel in the currently available devices, the protocols 
with such channels cannot be executed until these channels are matched with active device channels. Matching can 
happen in different ways: The protocol channel can be renamed to match the device channel, or a device channel in 
the active device can be renamed to match a protocol channel, or a new device that has matching device channels is 
opened.

When a protocol has channels that do not match your device channels, it cannot be executed, and the program marks 
such channels with an exclamation point. Another situation where the program cannot execute the protocol is when 
different devices have channels with the same name. When this happens, the program marks the icon of such chan-
nels with two exclamation points. 
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In order to distinguish device channels with the same name, the channel can be prefixed by the device or instrument 
name. In this case, the name of the channel is separated from the device name with a colon. Because of this rule, 
none of the devices, instruments and channel names can include the colon symbol. 

The program provides a convenient alternative to manually typing names of protocol channels. The channel item 
popup menu has a “Select” command, which lists all channels from currently opened devices, allowing you to un-
ambiguously choose the channel name. By default the dialog shows short names for the channels and adds a device 
or instrument name only to tredundant channel names. To show all names with device qualifiers check the checkbox 
“Show full names”. To change the name of a selected channel click the “OK” button. To leave the name unchanged 
click “Cancel”. To rename all protocol channels selected, click “All”. This is particularly useful when transferring a 
large set of protocols to a different experimental system.

Channel property items

Sampling period - Real value. Default value is 1 ms. Valid values >0. Cannot have additional or user-defined proper-
ties. Specifies the sampling period. Present for input channels only. Note that although any positive value will be 
accepted by the editor, the actual hardware may impose some restrictions on possible values. The sampling specified 
might be too fast for the hardware to perform, for example. If the device cannot perform recording with the specified 
period an error will be reported when the protocol is started. 

Record baseline - Boolean value. Default value is Yes. For input channels only. Present only if the protocol contains 
“Record baseline” property. Specifies whether data from the channel are actually recorded on the disk during the 
baseline recording cycle. 

Scale baseline - Boolean value. Default value is Yes. For input channels only. Present only if the protocol contains 
“Record baseline” property. If “Yes”, the data from the channel that was used for baseline subtraction will be multi-
plied by the stimulus scale value specified in the “Record Baseline” property of the protocol. This setting can be used 
to implement P/n leak current subtraction in patch-clamp recordings, for example. If the value is “No”, unmodified 
data will be used for baseline subtraction.

Baseline output - Possible values: Scaled, Unmodified, Const. Default value is Scaled. For output channels only. The 
item determines what kind of output will be produced on the channel during the baseline recording cycle.

- Scaled: The output relative to a holding value specified by the protocol will be multiplied during baseline recording 
by the scale value specified in “Record Baseline” property of the protocol. The scaled output will be generated from 
the baseline holding value specified in the “Baseline Value” property or the current holding value. This mode can be 
used to implement P/n leak current subtraction in patch-clamp recordings, for example.

- Unmodified: The output produced on the channel during a baseline recording cycle will be the same as during 
actual recording.

- Const: The output of the channel will not change during baseline recording. The output value will be set to what is 
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specified by the “Baseline Value” property or the current holding value. 

Baseline value - Real value. Default value is the holding value. For output channels only. The item specifies the 
holding value for the period of baseline recording. In order to use the same holding value as for the actual recording, 
delete this item by selecting it and pressing the “Delete” key on your keyboard.

Channel Menu

Select - Displays a list of all channels from currently opened devices. To select a channel click “OK“. Click “Can-
cel” to leave the name unchanged. To rename all the protocol channels in all protocols with the same name, click 
“All”.

Event - Text value (name). No default. Can have additional user-defined properties. The Event item specifies a mo-
ment in time during protocol execution. Event properties include actions performed on the channels, such as record-
ing start and stop, and changing the value of output channels. Each protocol will have at least one event item. Use 
“Add Event” command. 

Event Items Menu

Change Delay: Adds a “Delay” property item to the event. “Delay” property specifies the time period between the 
reference moment and the event.

Variable: A submenu containing commands that very the “Delay” property between iterations of protocol.

Change Delay Increment: Adds a “Delay Increment” property that specifies the value added to the “Delay” value 
on every iteration of the protocol. Used to introduce linearly changing timing into the protocol. 

Change Delay Multiplier: Adds a “Delay Multiplier”, which specifies the multiplier for the “Delay” applied on 
every iteration of the protocol. Used to introduce linearly-changing timing into the protocol. 

Change Increment Multiplier: Adds an “Increment Multiplier” property item to the event. This item specifies the 
value of the multiplier of the “Delay Increment” for every iteration of the protocol. Used to introduce exponentially 
changing timing to the protocol.

Change Increment Mode: Adds an “Increment Mode” property item to the event. This item determines the usage 
order of variable values of the delay sequence.

Set Reference Event: Adds a “Reference Event” property item to the event. This item specifies the event from which 
the delay of the event is measured. 

Insert Event: Inserts a new “Event” item before the selected event.

Append Event: Adds a new “Event” item at the end of the event sequence.
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Add Action on …: Introduces an action item to define operations performed with input or output channels during 
this event.

Event Properties

Delay - Real value. Default value is 0. Valid values >=0. Specifies the time period between the reference moment 
and the event. The reference moment for the first event is the moment of the current protocol start. The rest of the 
events by default specify their delay from the moment of the preceding events. The reference moment can be speci-
fied explicitly by adding a “Reference Event” property, which can refer to any event listed prior to its parent event. 
Use “Change Delay” command.

Delay increment - Real value. Default value is 0. Specifies the value added to the “Delay” on every iteration of the 
protocol. Used to introduce linearly changing timing into the protocol. Use “Variable - Change Delay Increment” 
command. 

Delay multiplier - Real value. Default value is 1. Valid values: non-zero value. Specifies the value of a multiplier 
for the “Delay” to use on every iteration of the protocol. Used to introduce exponentially changing timing into the 
protocol. Use “Variable - Change Delay Multiplier” Command.

Increment multiplier - Real value. Default value is 1. Valid values: non-zero value. Specifies the value of the mul-
tiplier to the “Delay increment” on every iteration of the protocol. Used to introduce exponentially changing timing 
into protocol. Use “Variable Change Increment Multiplier” command.

Increment mode - Possible values: Increment, Decrement, Interleaved Increment, Interleaved Decrement, Alternate. 
Default value is Increment. Determines the order of using variable values of delay during protocol iterations. At the 
beginning of the protocol a sequence of variable values is computed according to the values of “Delay Increment”, 
“Delay Multiplier” and “Increment Multiplier”. During the protocol execution the value for the delay is chosen from 
the sequence in the order specified by “Increment Mode” as follows: 
-	 Increment: The values are selected in the normal order beginning with the first value.
-	 Decrement: The values are selected in the reverse order beginning with the last value.
-	 Interleaved Increment: The values are selected starting from the first with odd and even values swapped.
-	 Interleaved Decrement: The values are selected in reverse order starting from the last with odd and even 		
	 values swapped.
-	 Alternate: The values are selected alternatively in the normal order beginning with the first value and in the 
reverse order beginning with the last value. 
Use “Variable - Change Increment Mode” command.

Reference Event - Possible values: Names of events preceding the parent event. This item specifies the event, from 
which the delay is measured. By default, when the “Reference Event” item is not present, the delay is measured from 
the start of protocol iteration for the very first event or from the immediately preceding event. Use “Set Reference 
Event” command. 
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Action

The Action item specifies an operation performed on a device channel at the moment specified by the event. The 
action is always associated with a single protocol channel. The association is established when the item is created 
and cannot be altered. Removing the channel from the protocol will automatically remove all actions associated with 
it. Each event can have as many action items as the number of channel items in the protocol. Use  “Add action on 
Channel” command. The icon of the action item is determined by the operation specified. The text label of action 
items starts with the name of the channel associated with this action and may provide additional details. The text 
label of action items cannot be directly edited.

Action Menu 

Set triggered start: Adds “Triggered” item to the action so that recording will start only upon arrival of the device-
specific trigger. Only present in menu of actions associated with input channels. 

Set Value: Adds “Value” for output signal. Only present in the menu of actions associated with output channels.
 
Set Increment: Adds “Increment” property item that specifies the value added to the “Value” property upon every 
iteration of the protocol. Used to introduce a linearly changing output into protocols. Present in the menu only if ac-
tion has “Value” property item. 

Set Multiplier: Adds “Multiplier” property that specifies a multiplier for the “Value” property upon every iteration 
of the protocol. Used to generate an exponentially-changing output. Present in the menu only if the action has a 
“Value” property item.
 
Set Increment Multiplier: Adds “Increment Multiplier” property that specifies the value of the multiplier for the 
“Value” property for every iteration of the protocol. Used to generate an exponentially-changing output. Present only 
if action has “Value” specified.
 
Set Increment Mode: Adds “Increment Mode” to determine the order of output values used. Present only if the ac-
tion has “Value” specified.

Action Properties 

Operation - The first property of the action specifies the operation performed on the channel. The chosen operation 
determines the icon used for item in the protocol hierarchy. 
- Start record - For input channels only. Starts recording into the file at the moment of the event. 
- Stop record - For input channels only. Stops recording into the file at the moment of the event. 
- Const - For output channels only. Outputs constant value. 
- Ramp - For output analog channels only. Starts producing a linearly changing signal starting at the current value 
and ending at the value specified by other properties at the moment of the next event. Note that if there is no event 
after the ramp, which is equivalent to next event being at infinity, the output will be constant. Note that recording 
stops with an error message if the ramp is specified for a digital channel. 
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- Square  - For output channels only. Starts producing rectangular pulses.
- Triggered - Boolean value. Default value is No. For input channels only. Starts recording action only. Specifies that 
recording will not start immediately but only after a trigger. The meaning of the trigger depends on the devices used. 
Not all channels and not all devices have the ability of a triggered start. When not implemented an error will be 
reported on an attempt to execute such a protocol. Use “Set triggered start” command. 

Value - Real value. For output channels only. Default value is the holding value or the output value of the channel 
at the start of the protocol. Valid value range depends on the hardware used (devices). Specifies the constant output 
value. Use “Set Value” command. 

Increment - Real value. For output channels only. Default value is 0. Specifies the value added to the “Value” on 
every iteration of the protocol. Used to generate a linearly changing output. Use “Set Value Increment” command.

Multiplier - Real value. For output channels only. Default value is 1. Valid values: non-zero value. Specifies 
a multiplier for “Value” to apply on every iteration of the protocol. Used to generate exponentially changing output. 
Use “Set Value Multiplier” command.

Increment multiplier - Real value. For output channels only. Default value is 1. Valid values: non-zero value. Speci-
fies a multiplier for “Increment” to apply on every iteration of the protocol. Used to generate exponentially changing 
output. Use “Set Increment Multiplier” command.

Increment Mode - Possible values: Increment, Decrement, Interleaved Increment, Interleaved Decrement, Alternate. 
Default value is Increment. For output channels only. Determines the order of output values to use during protocol 
iterations. At the beginning of the protocol execution a sequence of variable values is computed according to the 
values of “Increment”, “Multiplier” and “Increment Multiplier”. During the execution an output value for every 
iteration is chosen from the sequence in the order specified by “Increment Mode”:
-	 Increment: The values are selected in the normal order beginning with the first value.
-	 Decrement: The values are selected in the reverse order beginning with the last value.
-	 Interleaved Increment: The values are selected starting from the first with odd and even values swapped.
-	 Interleaved Decrement: The values are selected in reverse order starting from the last with odd and even 		
	 values swapped.
-	 Alternate: The values are selected alternatively in normal order beginning with the first value and in reverse 
order beginning with the last value. Use “Set Increment Mode” command.

Frequency - Real value. For output channels only. “Square” operation only. Valid values are determined by the 
device capabilities. Specifies the frequency of the rectangular periodic channel in Hz. Added automatically when 
“Square” operation is selected.

Duty cycle - Real value. For output channels only. “Square” operation only. Valid values between 0 and 1. May be 
limited by device channel capabilities. Specifies the duty cycle of the rectangular periodic channel. Added automati-
cally when “Square” operation is selected.

Analysis - No value. Compound item. This items requests online analysis at the end of each protocol iteration. The 
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text label, which is provided by the program automatically, gives a brief description of analysis. Protocol can have 
any number of analysis items. Use “Add analysis” command. The Analysis item describes the automated online 
analysis operation to perform during after each iteration the protocol. The online analysis may perform the same 
operations as interactive analysis. The results of online analysis are saved to the same file inside the recording item. 
The analysis will be performed only if the recording is saved to a file. The protocol can have any number of “Analy-
sis” items, each resulting in a separate data item in the file.

Analysis Property Items

Kind - Possible values: Average, Maximum, Minimum, This is a required property. Defines the type of analysis to be 
performed. The list of available analysis operations might depend on installed analysis components. 
X Value - Possible values: Trace Number, and other variable properties of the protocol. A required property. Defines 
what values will be used on the horizontal axis of the plot showing the results. The “Trace Number” is always pres-
ent if the protocol Count is greater than 1. If “Trace number” is selected for the X variable, each measurement will 
be identified by the sequential number of the protocol iteration. Any other variable property of the protocol will be 
listed as a choice. The “Running time” choice allows the analysis to run before the recording of the trace is finished, 
and can be used for real time analysis of continuous recording. In this case the analysis is performed on portions of 
the recorded data between time points defined by Start and Stop analysis properties.

Start and End - These two properties specify the time interval that will be used for analysis. Each has two proper-
ties: 
-	 Value: Real value. Defines the value for the time offset. The offset is measured from a specified reference 
moment or from the start of the protocol iteration. This is a required item, which is always present.
-	 Reference: Possible values: All events of the protocol. The item specifies the reference moment from which 
the offset, specified by the “Value” property, is measured. If this item is absent, the offset is taken from the start of 
the current iteration. Use “Set Reference” command. 
Data - Possible values: All suitable input channels. This item is specific to the type of analysis selected. Specifies the 
input channels for the analysis. Some types of analysis may require selection of more than one input channel. In this 
case some extra properties will be added automatically.

Chapter 4: Devices 
The program can work simultaneously with multiple user devices: interfaces and instruments. The devices, which 
are connected to the computer and recognized by the system, are listed in the Device menu of the main window. 
Before the program can use the device, it has to be activated (opened). To open the device, select its name in the 
“Device” menu of the main window. This will open a separate device window. Every opened device has a check 
mark next to its name in the “Device” menu. The main area of this window displays the data coming from the device 
through its input channels during protocol execution. In the case of an analog/digital interface, the data display area 
behaves like an oscilloscope. The window can also host various tools, which are device-specific, providing various 
means to control the device.

The program saves all settings related to a single device in a separate file. The first time the device is opened the 
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program automatically displays a setting dialog for the device. You can modify the default settings and save the set-
tings file in the location of your choice. Once the settings file for the device is saved, all changes to the device setup 
will be saved in this file automatically. The next time the program starts and the device is opened, the settings will be 
automatically loaded from this file. You can have multiple settings saved in different files tailored for different kinds 
of experiments. To save settings into a new file, open the “Settings” dialog and click the “Save as...” button. To load 
a different settings file, open the settings dialog and click the “Load...” button. Again the last loaded settings file will 
be automatically used the next time the program starts. Several users can share the same settings by saving the set-
tings file into a location that is accessible by all users.

Device Settings
Select the “Settings...” command from the “Settings” menu of the device window to access the setup dialog. Note 
that if the device is opened for the first time, this dialog opens automatically in order to create the file where the set-
tings will be stored.

The setup dialog has two panels. In the left panel all the resources of the device that can be configured by the pro-
gram are listed. This list is specific to each device but most types of resources are common, such as analog input 
and analog output channels. This chapter describes the settings for such common resources. Settings for resources 
that are unique for some devices are described in corresponding device driver manuals. The right panel of the setup 
window shows controls applicable to the resource, channel or instrument, selected in the left panel. Fig.15 shows 
example settings for an analog input channel.

The “Name” field is common for all types of channels. The default name is device specific and is usually a generic 
name for the channel plus its number to distinguish it from other similar channels, for example “Analog In2”. The 
experimental protocol refers to the channel by its name. Changing the name of the channel that is already used in 
protocol will invalidate these protocols and will require changing the corresponding channel name in the protocols 
as well. The protocol editor provides a way to change the name of the corresponding channel in all protocols at once 
through the “Select...” command (see chapter “Channels”).

The “Units” field provides a physical description of the signal acquired by the channel. If the unit name is provided, 
the measured values displayed by the program will be accompanied with the units using engineering notation with 
an exponential prefix preceding the unit name. Otherwise, the values are displayed using scientific notation with the 
mantissa followed by an exponent separated by the character 
“e”. 

The next control specifies whether the input value of the chan-
nel is saved before recording. This can be used for channels 
that read your hardware configuration like telegraph signals 
linked to the amplifier gain, for example. Available settings are: 
- Do not save value: The value will not be saved 
- Save value: The value will be saved in an appropriate info 
item. 
- Save value for every recording unit: The value will be 
sampled on every protocol iteration and saved in an appropriate 

Fig. 15
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info item. If the value of the channel is selected for saving, it is 
also displayed in the info area of the main window.

“Scaling type” specifies how the voltage on the terminals of 
the device is converted into the physical units. The scaling type 
can be chosen to be either “Normal” or “Discrete”. Normal 
scaling, as shown in Fig.15, requires a multiplier and an offset. 
To convert to the calibrated value, the voltage measured on the 
device terminal is multiplied by the multiplier and the value of 
offset is added. The multiplier may be calculated using sev-
eral components: the multiplier specified by settings, a value 
measured from another input channel selected in the “Variable 
gain” menu, and, on some devices, an additional gain provided 
by hardware built into the device.

In the case of “Discrete” scaling, the calibrated value is obtained from a look-up table of thresholds, which is speci-
fied by the user, as shown in the example on Fig.16. If the channel reading is less than or equal to the value in the 
first column in the first row of the table, the calibrated value is taken from the corresponding OUTPUT column in 
the first row. Otherwise, readings are compared to values from the second row and so on, until the appropriate row is 
located.

Not all settings described above are present for all types of channels. The digital input channels, for example, do not 
have scaling fields. Digital output channels may have a discrete scaling type, however, which may be useful in some 
systems that are able to generate a response to a digital code.

The program might treat digital channels as compound channels containing multiple channels corresponding to the 
individual bits and represented by integer numbers. The protocol can refer to these channels by their names so that 
individual bits of the digital channels can be used as if they are separate channels.

Device Tools
The program allows you to control various functions of devices through a set of tools. The device tool is a control 
panel. The tool panels are shown either along the right side of the device window or inside separate floating win-
dows bound to the device window. Each device window has a “Tools” menu that lists all the tools available for the 
device. Some tools are specific for particular devices. Some tools may work only with specifically configured de-
vices: when a device is configured to work with a particular user instrument, for example. This chapter will describe 
common tools available for most devices.The description of device- and instrument-specific tools is provided in the 
device manuals.

Every tool panel has a pop-up menu activated by clicking on the title of the tool. The tool menu always contains a 
“Close” command to remove the tool, and a “Float” command that toggles the position of the tool between docked 
on the right side of the device window and floating on top of all other windows. Some additional commands specific 
to the tool function might also be present in the menu.

Fig. 16
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A tool, when active, takes full control of the device and the display area of the device window. Because of that only 
one tool can be active at any given time. Many tools have an “On” toggle button that activates the tool. Clicking the 
“On” button to activate the tool will inactivate any other tool that was active. Also, starting the protocol will inacti-
vate all the tools in all devices that use channels referred to by the protocol. No tool can be activated until acquisition 
on all input channels is finished or the protocol is manually interrupted. 

Channel Monitor

The Channel Monitor tool works with any device that 
has either analog or digital channels. The tool may 
generate signals on several output channels and con-
tinuously monitor inputs of several input channels. 
Fig.17 shows a device window with the monitor tool 
active. The monitor tool has several controls for each 
channel. Pop-up menu selects the channel to monitor. 
In the case of output channels, the tool allows you to 
specify the constant value for output and the shape, 
amplitude and period of periodic output signals. The 
duration control sets the maximum signal duration 
displayed; only recent data for the specified duration is 
kept in the memory.

The duration also sets the initial scale for the horizontal axis. It is possible to zoom in order to view the data, but 
zooming out beyond the specified duration will reveal empty space beyond recently acquired data. To increase dis-
played time range, duration needs to be increased. The tool automatically sets sampling frequency so that there are 
enough data points to display. 
The menu of the channel monitor tool contains the following additional commands: 
-	 Add Input: Adds another input channel to display. The tool can show up to four input channels simultane-
ously, given the device has that many channels. The trace for each monitored input will have a different color.
-	 Remove Input: Removes the last input channel. 
-	 Add output: Adds another output channel. The tool can control up to two output channels. The output data 
will also be displayed in the data area in a unique color for each channel.
-	 Remove Input: Removes the last output channel.
-	 Separate axes: This is a toggle command. If selected, each trace is shown with separate vertical axes. If 
unselected, the traces are grouped according to the units. 

Digital Dashboard

The Digital Dashboard tool works with any device that has digital output channels. Fig. 18 
shows the tool in a floating window. This tool allows you to set and clear individual bits of 
digital output manually. The menu on top of the tool allows you to select any of the available 
digital output channels. The tool also allows you to simultaneously display all bits that were 

Fig. 17

Fig. 18
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given a name. Note that this tool does not have an “On” button. The tool performs its function instantaneously and 
does not take over control of the device for an extended period of time. This tool also does not use the data display 
area of the window. 

Chapter 5: Data Analysis
The program can analyze recorded data and extract numerical characteristics, such as av-
erage values. The analysis can be performed interactively on data recorded previously, or 
automatically during recording at the end of every iteration of the protocol. This chapter 
describes mostly the interactive analysis. Setting up the protocol for automated real time 
analysis is described in the chapter describing the experimental protocol.

The interactive analysis is started from the plot window displaying recorded traces. 
Analysis can be done on any collection of traces but usually it makes sense to analyze all 
traces from one channel belonging to a single recording. If the protocol has a single input 
channel you can double click on the recording in the file window to create the traces graph 
window. Select “analyze” from the “Data” menu to add interactive controls to the win-
dow. The analysis control panel behaves similarly to a device tool. It has a pop-up menu 
that can be accessed by clicking on the panel title. The menu allows you to close controls 
and to separate the panel into a floating window. Fig.19 shows the analysis control panel 
in a floating window. The selector on the top specifies the type of analysis to perform. The 
choices may include common operations such as average, minimum and maximum, and 
more specialized operations that may be included in some configurations.

Analysis Controls
Begin: & End: Controls specify a range of data for analysis. A selector specifies how the limit is determined. The 
“Absolute” selection makes the limit an absolute value as displayed by the horizontal axis. The “Begin:” limit on 
Fig.19 is specified using this setting. Selecting “Relative to” allows you to select the start of data recording, end of 
recording, or any event that is common for all the traces on graph. In this case the limit is specified as an offset from 
the selected reference point. The “End:” limit on the Fig.19 is specified using this setting. The numeric value for the 
limit can be entered manually into the text entry field, or it can be selected by dragging the mouse cursor over the 
graph. When dragging, both limits are selected. To change only a single limit, click on the graph near the limit while 
holding the “Shift” key on the computer keyboard, and drag the mouse to select the range. The selected data range 
will be highlighted.

X variable: Allows you to specify an independent variable for plotting analysis results. If the graph contains multiple 
traces you have a choice named “Trace number”, which is a sequential number of the trace. This sequential number 
is the order the trace was added to the graph, and not the order it was recorded. If the graph was created by double-
clicking the recording item, this number is the same as the recording order. You might have other choices if the 
output or timing values vary during protocol execution. Note that these values have to be present in protocols used 
for all the traces on the graph. If you add a trace obtained with a completely unrelated protocol, it may prohibit these 
extra choices. Usually analysis is performed once on every trace on the plot, and the X variable relates each point of 

Fig. 19
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the results to the trace that produced the result. There is one exception to this: if “Resampled” is selected by “X vari-
able” control. In this case each resulting trace is derived from the analysis of a single trace. During the analysis each 
trace is divided into smaller portions and analysis is performed on each portion. The portion length is determined by 
the distance between the “Begin” and “End” controls. The start of the first portion is selected by the “Begin” control. 
The independent variable of the resulting trace is a starting horizontal coordinate of each analyzed portion. The 
analysis is performed from the point selected by the “Begin” control until the end of the trace.

The group of controls below the “X variable” is specific to the analysis function chosen. In simple cases like average 
value calculation it will be just a selector for the trace to be analyzed. This control also allows you to analyze all the 
traces in a single run. Other analysis functions may provide some additional parameters, for instance a number of 
exponential terms for exponential curve fitting. Some functions may require selection of several traces, as in the case 
where the ratio of two signals is used in analysis, for example.

The analysis is performed when you click the ”Analyze” button. On the first time, a new plot window for the analy-
sis results will be created. You can change some analysis settings and click the “Analyze” button again. The results 
will be updated in the resulting plot. Finally, the resulting data can be saved into a file by clicking the “Save” button. 
A new file named “Analysis results” will be created and the resulting trace will be placed into a data item inside this 
file. You can save the results inside this new file or move the resulting item to the file containing the original data by 
dragging and dropping with your mouse. The latter approach allows you to store the analysis results together with 
recorded data in the same way as it would be done by an automated real time analysis. 

Extending Analysis with Python Language
The program allows you to use routine analysis functions written in the Python programming language. You can 
learn about Python at http://www.python.org. You need to download a specific version of Python - currently it is ver-
sion 2.4. If you have a different version of Python preinstalled on your computer, you will need to download and in-
stall the required 2.4 version. On MS Windows the directory where Python is installed will be included in the search 
path so that the program can locate the Python DLL file. The program looks for Python scripts in text files located 
inside the “Python” folder. The analysis functions will be located within the “Analysis” folder inside the “Python” 
folder. The analysis functions are regular Python modules but can use all facilities of the language, such as numeric 
and scientific libraries. The only requirement to analysis extension is to have a function named “Analyze” that will 
be called by the program when data analysis is performed. Below is a simple example of Python analysis extension 
that calculates the maximum of the data trace:

from Synapter import * def Analyze(data): 
val = max(data) 
return Value(‘Max Value’, val*data.YScale, data.YUnits)

The first line makes known all the data types provided by the program to communicate with Python. The second line 
defines the Python function that will be called by the system during analysis. The argument of this function, called 
“data”, will contain a sequence of data values from the trace to be analyzed. The third line does the actual analysis 
by applying the built-in Python function “max” to the data sequence and stores the result in numeric variable named 
“val”. The last line wraps the result into a special data type, which is returned back to the program. The first argu-
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ment gives a name to the result. This name  “Max Value” will be used by the program. The second argument is a 
floating number that contains the result. Note that the result is multiplied by a vertical scaling property of the data 
sequence (data..YScale). This is because the system provides the data sequence in the original format as recorded 
from input interface, which may be integer and not floating point numbers. The last argument provides the physical 
units of the result. In this case the result has the same units as the “data.YUnits” property of data.

Structure of Python Module 
Each extension analysis function is represented by a separate Python module, that is a text file located in the “Python 
Analysis” folder. In order to access data, the module will use the statement “from Synapter import *”. 

Module Attributes
The module can specify several attributes as a top level variable definition that will describe the extension so that the 
system can correctly represent the extension the same way as it represents built-in analysis operations. Any omitted 
attributes will result in default behavior.

Name
String value giving the name of the performed function. This name will be included into the function selector both in 
the analysis panel and in the protocol analysis setup. If this attribute is omitted the base name of the file containing 
the extension will be used.

VectorInputs
This attribute specifies the names of data arguments supplied to the analysis function. This attribute can be specified 
as a string value or a list of string values. For each string value the system will create a separate trace selector in an 
interactive analysis panel or input channel selector in a protocol analysis setup. If this attribute is omitted the “Ana-
lyze” function of the module will take single vector input as its first argument and this input will be named “Input 
data”.

ScalarInputs
This attribute specifies the names of analysis parameters, each represented by a floating point number. This attribute 
can be specified as a single string value or a list of string values. For each string value the system will create a sepa-
rate field to edit a floating point number in an interactive analysis panel or numeric item in a protocol analysis setup. 
If this attribute is omitted the “Analyze” function of the module will not list any scalar arguments.

Analyze Function
The module defines a function named Analyze. The function can take one or two arguments. The first argument 
is used to pass vector data for analysis as described by the VectorInputs argument. If the VectorInputs argument 
is absent, the first argument will be a data sequence of type Synapter.Data, otherwise the first argument will be a 
dictionary with keys being strings taken from VectorInputs, and values of type Synapter.Data. The second argument 
is used to pass scalar parameters for analysis as described by Scalarlnputs attribute. If Scalarlnputs is absent, the 
function will not have the second argument. Otherwise, the second argument will be a dictionary with keys being 
strings taken from ScalarInputs, and values of type Synapter.Value. The function will return a single object of type 
Synapter. Value, or a list of such objects. In case of multiple objects, the program will place values from each object 
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into a separate trace item. If the function cannot complete the analysis for some reason, such as arithmetic overflow, 
the function can raise a Python exception. The description of the exception will be given to the user in a message 
box. If an exception is raised during analysis performed as a part of recording protocol, the execution of the protocol 
will be stopped immediately.

Data Types

Value
Value is an object used to pass scalar parameters into the analysis function and return analysis results. Python can 
create new objects of this type using constructor Value(Name, Value, Units), where the arguments describe the fol-
lowing attributes. Attributes:

Name - String giving a name of the parameter.

Value - Floating point number 

Units - String giving the physical units for the parameter.

Data
Data is a sequence of numeric values used to pass trace data to the analysis function. As with other Python sequence 
objects, its elements can be accessed by index and iterated over the range. The Python analysis function does not 
need to create an object of this type by itself; you can use standard sequence types and types from numeric exten-
sions libraries for internal vector computations. All attributes of data are for read only and cannot be modified:

Name - String value giving a name to data.

YUnits - String value giving the physical units of data.

YScale - Floating point number giving the multiplier for data values to convert into values measured in units given 
in YUnits attribute. This property is required for data that were recorded as integer values from an analog interface, 
while actual physical value is obtained by scaling. 

XUnits - For data recorded with constant samplng interval this gives the name of physical units of such interval, usu-
ally seconds.

XScale - For data recorded with constant sampling interval, this specifies a distance between adjacent data points in 
units given by XUnits property.

LeftX - Gives the X value for the first data point.
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Serial Port Driver
The serial port device driver allows you to control external equipment by sending text commands through a serial 
port. The driver provides virtual channels that can be used in your recording protocols similar to other input and 
output channels.

Installation 
Place the serial port driver inside the “Devices” folder. The next time the program starts the Devices menu of the 
main window will contain new devices for each serial port available in your system. Note that the program cannot 
use serial ports that are under the control of other applications. If some of your ports are not listed in the menu, stop 
other programs that might use serial ports and restart the system. 

Setup 
Select a serial device from the Device menu of the program main window. This will open a new device window. 
The first time the device opens the Settings dialog will open automatically. If you need to change the setup, open the 
dialog by selecting “Settings” from the Settings menu in the device window. Initially, the serial port setup will con-
tain only one item in the properties list on the left of the dialog: Channels. Here you can specify the usual settings of 
the serial port. Consult your equipment manual to find the correct settings for the serial port. The equipment manual 
should also list available text commands and their functions. To include a carriage return symbol into the command 
text use “\r” (pair of symbols) during editing of the properties. On the bottom of the Channels properties panel you 
can find the button “Add channel”. Click this button to create a new virtual channel. All virtual channels are listed 
on the left list inside the Channels item. Select the virtual channel name in the list to edit its properties. The proper-
ties of the virtual channel are similar to the properties of analog output channels of your Digital/Analog interface 
devices. The main difference between virtual and analog channels is that the virtual channel’s properties specify the 
text command while the analog channel specifies the voltage value of the output. If “discrete” scaling is selected for 
virtual channel the command is selected from the lookup table. The closest value in the left column not exceeding 
the requested value will be found to send the corresponding text through the serial port. With “normal” scaling the 
program will apply an offset and multiplier to the requested value and convert the resulting value into a text com-
mand according to format specification given in the Command property. The command can be any text that includes 
the single number conversion command - either %g for general scientific representation that might include mantissa 
and exponential, %f for floating point representation, and %d for integer representation. Field width and precision 
can be specified optionally by including two numbers between the % sign and the format letter similar to this ex-
ample: %6.3f. Note: To include the percent character in the command string precede it with the backslash character. 

Usage
If the serial port device window is opened, all virtual channels that are defined in the setup are available for usage 
in the protocols. Note that the timing of the events controlling the serial port channels is derived from the computer 
internal clock, which might not be as precise as the dedicated clock inside the interfaces and measuring instruments. 
The program attempts to maintain the timing of the serial port event with 50 ms precision, but this may fail in the 
event of heavy load on the computer processing unit CPU.

The serial port device window provides controls to interactively apply values to the virtual channels. For each chan-
nel there is a separate control that allows either direct entry of output values with normal scaling, or selector of the 



37

value for channels with discrete scaling. To send the corresponding command, press the small button next to the 
value control.

The device window can also show a simple terminal to send arbitrary text to the serial port and to monitor the re-
sponse from the serial port. To use the terminal select “Show terminal” from the Settings menu. Type the text in the 
lower edit field of the terminal. The text is sent to the serial port only after you press the ENTER key on the key-
board. The characters received from the serial port are displayed in the upper part of the terminal window. To remove 
received text from the terminal display, select “Clear input” from the Settings menu.
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